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Chapterl. Overview and Main Features

1-1. Introduction

Arduino is an open-source electronics prototyping platform based on
flexible, easy-to-use hardware and software. It's intended for artists,
designers, hobbyists, and anyone interested in creating interactive objects or
environments.

1-2. Board Features

+ ATMEGA168 microcontroller.

+ AVR ISP connector for programming with AVR ISP.

+ USB interface (Virtual COM Port).

+ Quartz crystal 16 MHz.

+ Status LED.

+ Reset Button.

+ Power plug-in jack with diode bridge can be powered with AC or DC
power supply.

+ Powered via the USB connection or with an external power supply
select by jumper.

+ PCB grids 100 mils.

+ PCB FR-4, 1.6mm. , red solder mask, white silkscreen component
print.

+ Dimensions 134.62 x 81.28 mm.
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1-3. Board Layout
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1-4. Connector Descriptions
1. AVR ISP
Signal
PIN #
Name 2 4 6 8 10
1 MOSI
2 +5V
3 NC
4 GND
5 RESET
6 GND
7 SCK
8 GND
9 MISO
10 GND
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2. PWR Connector

PIN # Signal
Name
1 7-12VDC

2 GND

1-5. Jumper Descriptions

1. Power Selection
+ Power from USB

USB/EXT

+ Power from external supply

USB/EXT

1-6. Board Dimensions
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1-7. Schematic
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Chapter2. Getting Started

2-1. Safety Instructions

Observe the following safety guidelines when connection and using your
FREEDOM-168 board:

+ Place the FREEDOM-168 board on an insulation surface and treat it
carefully. The FREEDOM-168 board can be damaged if dropped.

+ Put your FREEDOM-168 board in a location with low humidity and a
minimum of dust.

+ Never use your FREEDOM-168 board if the power cable has been
damaged. Do not allow anything to rest on the power cable, and keep
the cable away from where people could trip over it.

+ Never insert anything metallic into the FREEDOM-168 board. Doing
SO may create the danger of electric shock.

+ To avoid electric shock, never touch the inside of the FREEDOM-168
board.

+ The FREEDOM-168 board are provided for ventilation. To prevent
overheating, these openings should not be blocked or covered. Also,
avoid using the FREEDOM-168 board on a bed, sofa, rug, or other
soft surface.

+ Do not expose the FREEDOM-168 board to rain or use it near water.
If the FREEDOM-168 board accidentally gets wet, unplug it and you
can clean the exterior of the FREEDOM-168 board with a damp cloth
when necessary, but be sure to unplug the FREEDOM-168 board
first.
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2-2. Install the USB driver to PC

1. Connect the USB port of FREEDOM-168 board to PC then the window
will be found new hardware as follow.

jr,J Found New Hardware

FT232R USE UART
o
EN *‘)"'-' @ s 2 BEE 0z
Figure 1

2. Then information will be shown the found new hardware wizard then
choose “No, not this time” and click “Next” as follow.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will zearch for current and updated software by
looking on your computer, on the hardware installation CD, or on
the ‘Windows Update ‘web site [with vour permizzion).

Flead our privacy Rolicy

Can 'Windows connect to \Windows Update to search for
software?

() s, this time arly
() s, now and every time | connect a device
| (3) No, not this time

Click Mest to continue,

I Mest » % ’ Cahcel

Figure 2
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3. Choose “Install from a list or specific location (Advanced)” and click
“Next” as follow.

Found New Hardware Wizard

Thig wizard helpz you install software for:

FT232R USE UART

\) If pour hardware came with an installation CD
“= or Hoppy dizk, inzert it now.

What do you want the wizard to do?

) Install the software automatically [Fecommended]

|{£} Install from a list or specific location [Advanced)

Click Mest to continue.

[ < Back ]I Next>[k|[ Cancel

Figure 3

4. Choose “Search for the best driver in these locations” and choose
“Include this location in the search” and click “Browse” as follow.

Found New Hardware Wizard
Pleaze choose your search and installation options. .

(#) Search for the best driver in these locations.

Usze the check boxes below ta limit or expand the default search, which includesz local
paths and removable media. The best driver found will be installed.

[] 5earch removable media [floppy, CO-ROM...)
Ihclude this location in the search:

D:AFREEDOM-168_CD4Driver\COM 2.04.06 WHAL + Bronwse [:

() Don't search. | will chooze the diver to install,

Chooze thiz option to select the device diver from a list. ‘Windows does not guarantee that
the driver you chooze will be the best match for pour hardware.

[ < Back ][ Mest » ][ Cancel

Figure 4
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5. Choose the folder of USB driver from CD-ROM is “CDM 2.04.06
WHOQL Certified” and click “OK” as follow.

Browse For Folder @

Select the folder that conkains drivers for your hardware.

[ Free A~
= [7) FREEDOM-168 D
= [ Driver
) COM 2.04.06 WHOL Cegtified |
uﬂ Fuse EF
[ Manual
I P
[ Software

L =T NN R SRR 0 SO

To view any subfolders, click a plus sign above.

[ Ok ] [ Cancel

Figure 5

6. Click “Next” to searches “USB Serial Converter” as follow.

Found New Hardware Wizard
Please wait while the wizard searches... .

@ FT232R USE UART

Figure 6
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7. Then information will be shown completing the found new hardware
wizard and click “Finish” as follow.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

% ISE Serial Corvverter

Click Finish to cloze the wizard.

Finizh [

Figure 7

8. Then information will be shown the found new hardware wizard again
then choose “No, not this time” and click “Next” as follow.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for cument and updated software by
looking on wour computer, on the hardware installation CO, or on
the ‘windmmz pdate web site [with vour permizzion).

Fead our privacy policy

Can Windows connect to Windows Update to search for
zoftware?

) Yes, this ime only
1 es, now and every time | connect a device
{33 Mo, nat this time

Click Mest to continue.

I Mext » %[ Cancel

Figure 8
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9. Choose “Install from a list or specific location (Advanced)” and click
“Next” as follow.

Found New Hardware Wizard

Thiz wizard helpz you install software far:

|USE Serial Port

\;1 If your hardware came with an installation CD
“2 or Hoppy disk, inzert it now.

What do you want the wizard to do?

() Install the software automatically [Fecommended)

| (%) Install fram a list or specific lacation [Advanced) |

Click Meut to continue,

[ < Back ]I Mext » %I[ Cancel

Figure 9

10. Choose “Search for the best driver in these locations” and choose
“Include this location in the search” and click “Browse” as follow.

Found New Hardware Wizard
Pleaze choose your search and installation options. .

(%) Search for the best driver in these locations.

Use the check boxes below ta limit or expand the default search, which includesz local
paths and removable media. The best driver found will be installed.

[] 5earch removable media [floppy, CO-ROM...)
Ihclude this lacation in the search:

D-\FREEDOM-168_COADriver\COM 2.04 06 WHAL

() Dan't search. | will chooze the diver to install,

Chooze thiz option to select the device diver from a list. ‘Windows does not guarantee that
the driver you chooze will be the best match for pour hardware.

[ < Back ]I Mest > %[ Cancel

Figure 10
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11. Choose the folder of USB driver from CD-ROM is “CDM 2.04.06
WHQL Certified” and click “OK”.
12. Click “Next” to searches “USB Serial Port” as follow.

Found New Hardware Wizard
Please wait while the wizard installs the software. .. .

(3 LSE Serial Part

Figure 11

13. Then information will be shown completing the found new hardware
wizard and click “Finish” as follow.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finizhed inztaling the zoftware for:

(3 I15E Serial Port

Click Finish to cloze the wizard.

Figure 12

www.mlt-group.com www.avrcontrollers.com
Tel. 081-027-0918 Email: mlt@windowslive.com



14. If completely installed the driver, The USB-LED of FREEDOM-168
board will be displayed green colour and if check “Device Manager” will be
shown “USB Serial Port (COM4)” as follow. Here COM4 is just an example.
Different PC may have different COM port.

L Device Ma nager EJ El El

File Action  Yiew Help

S 2 8 =®Ka

+- ok DYDCD-ROM drives Fs
+- 48 Humnan Inkerface Devices

= IDE ATAJATAPI controllers

i Kevboards

') Mice and other pointing devices

L Manitors

B8 Mebwork adapters

\> MWIDIA Metwork Bus Enumerator

5 Ports (COM & LPT)

(;y" Communications Port (COM1L)

T e e o o e ey B

FroCess0rs

+ @% 551 and RaID controllers

+- @), sound, video and game contrallers
+|-Eg@ Storage volumes

+- i Swstem devices
+ Universal Serial Bus controllers

Figure 13
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2-3. Starting FREEDOM-168 board

After already installed the USB driver to PC.

1. Copy the folder is “Arduino-0011" shown in the “Software” folder from
CD-ROM to PC drive C:\Program Files.

2. Open drive C:\Program Files\Arduino-0011.

3. Choose “Arduino” and double click “Arduino” as follow.

& arduino-0011 M(=(E3]
File Edit ‘iew Favorites Tools  Help "}‘
@Back - J L?: /':\] Search li. Folders v
A |13 <\ Program Files)arduino-0011 v| Ga
File and Folder Tasks A 1 drivers I""] examples ;’] hardware
@ Rename this file g
L} Mave this File By . D= e
- s java ] lib [ reference
[D Copy this file ",] "’]
€N Publish this file to the Weh
g E it e e | sketchbaok ‘%| cygicory-2.dll
Delete this file
P cyqwind . dil s —TT
Dther Places éﬂgiii%uﬁgsm Ernulation DLL ‘%| ICEMIRegsry |- thes
|5) Program Files P .~ 4 e
() My Documents . 6.?.513.1 = Toxt Fle MS-DOS Batch File
[ Shared Documents LibLISE-#n32 - DLL = 11kB 1kB
i My Computer ?
ﬁd Iy Metwork Places L rxbxSerial.dl
Details
Figure 1
4. Choose “ Tools > Board > Arduino Diecimila ” and click “Arduino
Diecimila” as follow.
[¢| Arduino - 0011 Alpha
File Edit Sketch Bill=
Auto Format Clrl+T
Copy for Forum
Archive Sketch
* Blink Serial Port b Arduing WG or older w ATmegad
® Burn Bootloader b Arduino MG or older wi ATmegal 63
* The bazic AFOUING EREmpIe.  IUL  Arduing Mini
# then off for one zecond, and so [T
. ) )
depending on your Arduine board LilyPad Arduing
* or a built-in resistor 50 that Fee—rreco—errey—err—rrr
Figure 2
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5. Choose “ Tools > Serial Port > COM4 " and click “COM4” as follow.
Here COM4 is just an example. Different PC may have different COM port.

[£] Arduino - 0011 Alpha
File Edit ZSketch REsslE

Auto Format Crl+T
Copy for Forum
Archive Sketch

F 4+ 4 =

The basic ATOUIT

Figure 3

6. Choose “ Sketchbook > Examples > Digital > Blink " and click “ Blink ”
to test FREEDOM-168 board as follow.
Note: Here Blink is an example which LED (D13 port) of FREEDOM-168
board will be displayed blink with the rate is ON = 1 Sec. and OFF = 1 Sec.

[ Arduino - 0011 Alpha
=N Edit Sketch Tools  Help

Mery Crl+n

CtriC

Sketchbook

Open...

Save Ctr+s Exatnples Analog b
Save Az Ctrl+Shift+= Communication ]
Upload to 110 Board  Cei+l Digital b M
Page Setup Ctrl+Shift+P Library-EEPROM ] BlinkithoutDelay
Prirt Cirl+F g, Turns on &t | jorarye-hiatric ] Buttan
Preferences Chri+, and 20 on... Library-SoftwareSerial ¥ Debounce
; jo board, it hac Library-Stepper ] Laog
Gt Cirka o that vou need .
. Library-wire r
Figure 4
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7. Then information will be shown the C language code as follow.

(%] Arduino - 0011 Alpha
File Ecit Sketch Tools Help

) g

* Blink

* The baszic Arduino exawmple. Turns oh an LED on for one second,

* then off for one second, and 30 on... We use pin 13 because,
* depending on your Arduino board, it has either a built-in LED
* or a built-in resistor so that vou need only an LED.
w
* htrtp: /A, arduing. cofen/Turtorial /Elink
i
int ledPin = 13: A/ LED connected to digital pin 13
woid setup() A4 run once, when the sketch starts
{
pinMode {ledPin, OUTPUT) /¢4 getz the digital pin as ourput
}
wold loop () FAf run over and owver again

{
digitallrite(ledPin, HIGH) : /4 sets the LED on

delav(l000); A7 waits for a second
digitallWrite(ledPin, LOW); /f sets the LED off
delayilooog ; A4 waits for a second

Figure 5
8. Choose “ Sketch > Verify/Compile” and click “Verify/Compile” to verify
and compile the C language code.

(2] Arduino - 0011 Alpha
File  Edit

Itmport Library
i Showy Sketch Folder  Crl+k
* Blinl Add File...

% The bazgic Arduino example. Turns on an LED on for one second,
% then off for one second, and so on... We use pin 13 because,
% depending on your iLrduino board, it has either a built-in LED
* or a built-in resistor so that you need only an LED.

*

*

http: /g, arduine. cofen/Tutorial /Blink

Figure 6
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9. If the code is correct and not found data error then information will be
shown “Done compiling” and “Binary sketch size” as follow.

Done campiling.

Binary sketch sis 025 bytes (of a 14236 byte maXximam)

Figure 7

10. Choose “File > Upload to I/O Board” and click “Upload to I/O Board”
to upload program into FREEDOM-168 board as follow.

[2] Arduino - 0011 Alpha
{IEN Edit Sketch Toolz  Help

ey Cirl+h

Sketchbook b

Save Cirl+=

Sawe As.. Cirl+Shift+5

Upload to /0 Board  Crl+U

Page Setup Clrl+Shift+P

Prirt Ctrl+p e. Turns on an LED on for one second,

Preferences Cirls, and so0 on... We use pin 13 because,
10 board, it has either a built-in LED

Gt Clrl+

o that you need only an LED.

W

* http: A Awmmr, arduino, oo fen/Tutorial /BElink
*

Figure 8

11. If completely uploaded program then information will be shown “Done
uploading” and “Binary sketch size” as follow. And LED (D13 port) of
FREEDOM-168 board will be displayed blink with the rate is ON = 1 Sec. and
OFF =1 Sec.

Cone uploading.

Binary sketch =size:

Figure 9
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2-4. Troubleshooting Tips
1. No Power — The board’s power indicator is off.
+ Make sure the power selection (Jumper selection) is correct.
+ Make sure the board power cable (USB cable) is fully inserted in
the board's power port.
2. No Signal — The board’s power indicator is on but there is no signal.
+ Ensure that the signal cable (USB cable) is properly connected to
the board.
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Chapter3. Index
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3.1.1. www.arduino.cc
3.1.2. www.atmel.com

3.1.3. www.ece.com.tw
3.1.4. www.wealthmetal.com
3.1.5. www.freeduino.org
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3.2. Contact us

3.2.1. ML-Technology (MLT) sells products on Ebay.
If you will buy our product via Ebay.
Seller ID is m|12009.

e
3.2.2. ML-Technology (MLT) accepts Paypal payment.

If you will buy our product via Paypal.
Paypal account is mit@windowslive.com

PayPalj

3.2.3. www.mlt-group.com
www.avrcontrollers.com
Email is mlit@windowslive.com
Tel. 081-027-0918
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